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HA−6400
Côr� Home Automation
Installation FAQs

Technical Supplement
Subject:  A list of the frequently asked questions from the installation of the Côr� Home Automation
panel.
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USERS / NOTIFICATIONS / REPORTING / SCHEDULES

Q − Is there a signal sent via email when the Master User enters and exits the setting menu?

A − Yes, whenever the Settings menu is accessed, an email notification will be sent.

Q − Can the installer add Users and User PIN?

A − No, the installer cannot add Users and User PIN to the system.

Q − How many different schedules can be programmed?

A − There are a total of 16 schedules.

Q − Can a schedule be used in more than program?

A − Yes, that schedule can be used as many times and in as many different programming locations as needed.

Q − How many email addresses can be configured?

A − All 16 Channels can be used for email notification if Central Station reporting is not desired.

Q − What does Channel mean?

A − A channel is a communication path to a Central Station or to an email address. There are 3 channels that are defaulted for Central Station
communication and 13 that can be used for email notification. They are labeled Central Station Primary/Secondary/email 1/etc, but the labels
are arbitrary. All 16 channels can be used for email or Central Station.

Q − Can there be more than one Master Code programmed into the Côr� system?

A − Yes, Only a Master Code can make another Master Code. This is generally used when there are multiple Areas/Partitions in the system.

Q − What report that is sent to the Central Station when the IP and Wireless (Cellular) paths go down?

A − Contact ID code is E351 for cellular fault, and IP does not report or log a Wi−Fi� or Ethernet fault.

Q − How long will the IP or Wireless (Cellular) paths have to be down before the report is sent to the Central Station?

A − The amount of time a panel uses to shut down the remote access is the same as the “AC Report Delay Time”.

Q − Is there an event written into the event history when the DLX900 is connected?

A − Yes, it will be under the User name of “Downloader”.
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Q − How are Email notifications set−up?

A − Email is setup in the Reporting and Notifications menu under Settings. Select the first available slot under Select Channel to Configure
and assign a name. In the Format dropdown menu, select Email and enter a valid email address in the Destination field below. Click Save
when finished.

Q − How many alpha/numerical characters can be used in a SSID password?

A − 32 digits is the maximum.

GENERAL INFORMATION / SETTINGS

Q − Where do I find the IP address of the Côr� panel?

A − By logging via the web portal with the Installer Code and looking under Network or on the front of the panel Menu > 8 > Installer PIN
> Enter > then press 6.

Q − How does the panel set the Clock time?

A − The Côr� will automatically get clock information from pool.ntp.org. The only programming option that needs to be configured is the
Time Zone (Settings > System).

Q − What are the different Stand−By battery readings?

A − Below 9.5 V − Disconnected
        Below 10.8 − Low Battery
        Greater than 12.3 − Restored

Q − What routers are supported?

A − We do not support 802.11N today. Only support 802.11 B/G. 802.11N standard is backward compatible to B/G so any N routers will
work with  Côr�.

Q − Where can I find the latest install and consumer videos?

A − Homeowners can locate the consumer videos on navigating through their Smart Home app at
https://www.youtube.com/watch?v=hrDKSh9j>_RI&list=PLG1EONGo9APYgoI02On5hl5a7cvtf3SE or dealers can access from
HVACpartner.com > Marketing Tools > Sales Tools > Marketing Launch Kits > Côr Home Automation.

Q − How do I get the hardwired Siren to follow the siren timeout?

A −Login to the panel IP address as an installer and go to Advanced > Devices > System Devices > Control. Select which Control Output
you are using. Under Action Assignment  > Action select 17 Any Siren. Click Save when finished.

Q − How do I upgrade the firmware to the panel?

A − Login to the Dealer Portal (https://webportal.ultraconnect.com) and locate the specific panel that you want to upgrade. Note: If the Line
item is not highlighted in green then this would indicate the panel is not connect to a Wi−Fi� network and you will not be able to push out an
update to the panel at this time. Click on the Globe icon to the right of the screen. On the following screen, click on the Update button near
the bottom left. Select the firmware that you want to use; check the Auto−activate box; and click on Update. After a few minutes, the panel
will beep indicating that the firmware has been activated.

Q − How do I upgrade the firmware to more than one panel?

A − Login to the Dealer Portal (https://webportal.ultraconnect.com) and select Firmware Versions from the Admin dropdown menu at the
top right corner. Locate the latest firmware (usually at the top) with Zerowire as the HW Name and click on the icon with the Down Arrow
Circle to schedule a batch firmware upgrade. Designate the account number range of the panels that you want to upgrade and click on
Update. For example, you can enter 0000 and 9999 to upgrade all the panels that are currently connected to a Wi−Fi� network. After
approximately 5−10 minutes, click on the Download jobs tab at the top of the firmware list screen. Click on the A icon on the right of the
screen next to any of the panels that have completed the download. Select Activate All.

Q − How do I delete a provisioned panel from my UltraSync Dealer Portal?

A − Login to the Dealer Portal (https://webportal.ultraconnect.com) and select Service Request from the Admin dropdown menu at the top
right. Click on Create Request button on the right of the screen and select Deactivate/Delete a Unit. Select the serial number of the panel
that you wish to remove from your portal account and check the box Remove Permanently before clicking Create to complete the removal.
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Q − How do I change the Service Grade of a provisioned panel from my UltraSync Dealer Portal?

A − Login to the Dealer Portal (https://webportal.ultraconnect.com) and select Service Request from the Admin dropdown menu at the top
right. Click on Create Request button on the right of the screen and select Change Service Grade. Select the Account Number (serial
number) of the panel and Service Grade from the dropdown menu before clicking Create to complete the update.

Q − How do I change the spoken language of the panel?

A − Login to the panel as an installer and click on Settings > Systems. Under Voice Language, select the desired spoken language from the
drop−down menu that you want the panel to enunciate.

Q − How do I change the displayed language of the app?

A − In the main My Site screen of the app, click on the hamburger menu on the top left corner and select the language that you want to use
under Language.

Q − How do I change the lighting and chime sound level on the secondary touchscreen panel?

A − Click on the hamburger menu in the top left corner and select Touchscreen. Toggle the respective setting to the desire level and display
lighting level.

CAMERAS

Q − Can the camera record sound as well?

A − Yes, By default, the audio is turned off because many states have laws around audio recording. Login to the Camera IP in TruVision and
change the audio setting for sub−stream and post−stream.

Q − Can cameras be viewed if the Wi−Fi� network is down?

A − No, cameras use the Wi−Fi� network to send the video out. The Cellular connection is not used for video streaming due to the amount of
data usage required to view.

Q − How many cameras can be viewed at once?

A − One camera at a time can be viewed in the live mode.

Q − How many cameras can be on one system?

A − There are a total of 16 cameras that can be added to the Côr� system.

Q − When you default (reset) the panel, does it default the camera programming?

A − Yes

Q − I am logged in the TruVision portal using the camera IP address but cannot see the video under the Live Stream tab.

A − Login to the TruVision portal using Internet Explorer and download the plug−in if prompted.

Q − Can I use different cameras and add it to the Côr� system.

A − No. The Côr� system is currently compatible with the following cameras and firmware version: 
RS−3130 Indoor Desktop camera, the released FW version is V5.1.i
TVW−3120 Outdoor Wedge camera, the released FW version is V5.1.h (wedge camera does not use V5.1.i).

Q − How do you use the Cor� Smart Home app to watch earlier recordings?

A − Once logged into the Site app, click the top menu in the left corner and go to History for previous recorded videos.

Q − The camera screen on the app says “ Camera unreachable or authentication fail”. What could be wrong?

A − The camera may have lost a previous Wi−Fi� network connection. Power cycle the camera and log back in the app. If this does not
resolve the issue, repeat the camera installation steps and re−enter the Wi−Fi� network until it shows connected.

Q − Can I configure the outdoor camera to record a video clip based on motion?

A − Yes. There is a Technical Supplement document available on HVACpartners.com in the  Product Catalog under Côr� Home Automation
that will provide instructions on how to utilize the output of the cameras for recording video and to program the automation.
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Q − Can I modify the length of the video clip from 15 seconds to something different?

A − Yes. Log into the camera IP address* and go to Configuration > Storage. Change the length of the video by selecting from the
dropdown menu under Pre−Event and Post Event. Click Save when finished.

*Reference the Camera Installation Instructions or Login to the Panel IP as the installer and obtain the current camera IP under Settings >
Camera. Launch the web browser and type in the camera IP address. Please note that your computer must be on the same Wi−Fi� network as
the camera.

Q − What happens if I pull out the SD card and re−insert it?

A − SD card slot is not hot swappable and would need to reformat and reinitialize after insert. So please make sure that you power down the
camera, insert the original 8G SD card, power up and check if the SD card re−initializes and re−formats.

Q − I removed the SD card and attempted to view the video on my computer but the computer says the format cannot be played. Is there a
program that will play the video?

A −  The video format is H.264 and you can download a VLC video player to play back the videos.

Q − If I want to increase the memory size, can I use any SD card?

A − No. Below is a list of card brands that were tested.

SD card supported list
Micro SD/micro SDHC/micro SDXC slot supporting memory card up to 64GB (8GB card included).

Brand Capacity

Kingston

2G

4G

8G

16G

32G

ADATA

2G

4G

8G

16G

32G

SanDisk

2G

4G

8G

16G

32G

64G

Samsung 64G

SENSORS

Q − Can there be custom sensor names?

A − Yes, there are 2 ways; first there is a list of Voice Tokens that can be used to create a custom name for each sensor, the second is to record
a 3 second name for the sensor.

Q − How do I clear an RF Jam signal?

A − This option is turned on by default, it does not monitor a single zone (sensor) it is a function of the receiver and the background noise
floor of the receiver. Once it detects a Jam it will latch on the screen until it is acknowledged by a PIN.
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Q − How long will it take the panel to go into an RF Jam failure?

A − The panel must see a constant 319.5 MHz for 45 seconds before it will activate the RF Jam signal.

Q − How do you remove the panel from saying Zone X from the chime mode?

A − For that zone do custom zone name, in that name say nothing. The panel will “Ding Dong” then say the sensor number such as “Ding
Dong 1”. Menu > 6 > Code > Enter then 4 > {zone number} > Enter > hold the History Key

Q − Can the  Côr� have a “Common Lobby” area?

A − Yes, the sensors that are assigned to both areas (partition), when the last partition is armed those sensors would arm. The reverse on the
entry also exists − as soon as the first partition is disarmed all the common lobby zones will be disarmed.

Q − What are the resistor values for   Côr� hardwire sensor (a.k.a. Zones)?

A − 3.3K for Single Zone − 
For Dual End of Line (EOL) resistors 3.74k for zones 1 & 2 and 6.98 for zone 3&4.

Q − Can the homeowner check the sensor signal strength?

A − Yes, this can be checked through the front keypad via a sensor test. The panel will read out the dB level and also beep the number of
packets received. There needs to be a minimum of 6 to 8  beeps for each sensor opening.
Menu > 4 > User Code > Enter > then 4 > then activate the sensor(s)

Q − How can I delete/remove a Sensor using the DLX900 software?

A − In the top menu tab, select Devices > Transmitter. Manually delete the serial number information of the sensor that you want to
delete/remove from the panel. Click on Send Page (or Send Menu if there is more than one sensor changed).

Z−WAVE�
Q − When you default (reset) the panel, does it also default the Z−Wave� modules?

A − No, the Z−Wave� programming is held separately.

Q − How many Z−Wave� “Rooms” can be configured within the  Côr� Smart Home app?

A − There can be a total of 16 rooms.

Q − Is there a list of additional Z−Wave� devices that are available in the market?
A − Yes, Please reference the Product Bulletin in HVACpartners.com for the latest list. HVACpartners.com > Product Catalog > Home
Automation > Panels and Kits > Bulletins

ERROR MESSAGES
Q − I am getting an error message that says “Alarm system unreachable or passcode incorrect”.
A − Re−type your Passcode in the Site Info screen.

If the error message continues to appear, check the Status button of the panel. If the panel says “Monitoring Fault Link” then the panel has
lost Wi−Fi� network. Check the Wi−Fi� network to verify it is working properly.

If the panel is connected to a Wi−Fi� network then likely the Passcode used is incorrect. Login the Panel IP Address as the installer. Go to
Setting > Network and scroll down to where the Web Access Passcode is displayed to verify the information. If this is the case, re−enter the
correct 8−digit Passcode in the Site information screen of the app.

Q − The Status button on the panel is saying “Fail to communicate” but everything seems to be working correctly.
A − This might be tied to the panel attempting to send a notification to a previous User that was setup in the app. Login to the panel as an
installer and select Reporting and Notifications menu. Select the Channel number that is mentioned in the error from the drop−down menu.
Check Format has Email as the drop−down selection and the Next Channel has disabled as the drop down selection.

Q − The panel has a “Control Ethernet Link Fault 2” error message.

A − Check your Wi−Fi� network to make sure it is working properly. If fault is still present, power cycle the panel by also removing the
back−up batteries.
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Q − When I attempt to login to the Outdoor camera IP address on Internet Explorer, I receive a Network Abnormal error message after
entering the Admin and 1234 login credentials.
A − Perform a hard reset of the Outdoor camera by removing the front face cover and pressing/holding the Reset (RST/WPS) button near the
camera eye lens for 20 seconds.
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